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2. Locate tab: To view sample in microscope

Use pre set configuration tabs to view sample in
microscope

To create buttons:
Microscope control tab
Click on icons to choose light source and filter
combinations
Save configuration
Assign – creates shortcut button

1. Turning on:

Near the top of the control
panel, select Show all tools

To show all functionality:
From the drop down menu,
select View > Show all
(global). Or tick Show All in
each tab as needed

Switches on controller:
Main switch, Systems PC (if separate RTPC, wait for full boot up)
Turn PC on , and then Components
[System dependent: Fluorescent light source / For 710/780 Argon laser]

Open Zen software using desktop icon, and select Zen System for acquisition

Control
panel

Preview
window

Display controls

Ga
lle
ry

Workspace Zoom
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3.1) Lasers
Turn on lasers
The multiline 458,
488, 514nm laser
takes 5 mins to warm
up.

4.0

4.1

3. Acquisition tab and turning lasers on:

Imaging Mode:
Live: Fast 512x512 no
averaging
Continuous: As defined in
Acquisition Mode tab
Snap: Takes one snapshot of
all ticked tracks/channels as
defined in Channels.

Start Experiment: All
channels as defined for all
selected parameters (Z, Time
Series, bleaching, etc.)

3.1
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4. Smart Set up / 4.1 Imaging Set up
Single track set up

Multiple tracks = sequential (reducing crosstalk)
Allows changing hardware / specific filters between
frames

NOTE NUMBER
OF TRACKS

Acquires longer wavelengths first

Single

Multiple

Use the drop down menus to select your
dye combinations. Click OK to apply.
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Imaging Setup tab:

Select: Show all, LSM and Channel

Tick your detectors, choose fluorophores
and LUT colours from drop down menus.

Adjust detectors to collect appropriate
wavelengths using sliders, or typing range.
Adjusting all detectors at this point will
reduce movement between tracks.

An additional detector can be created
using the Plus button (by duplicating the
central detector if the system has a 32 Ch
GaAsP detector).

5. Setting up with Channels and Imaging Setup (without smart set up)

Arrange detectors and filters

Create the number of sequential tracks needed with the plus
button (Maximum 4 tracks).

Specify: Line / Frame / Frame Fast
(Line and Frame Fast require the same hardware between all
tracks. I.e. same detector positions between all tracks, MBS)

For each track button (at the top) select the appropriate
detector(s), laser(s) and MBS combination for the Vis and
InVis laser lines:

The T80/R20 can be used for multiple laser lines or reflection,
but is not advised unless you have experience.
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In Channels, click on the track you want to adjust so it becomes highlighted. The chosen track will
then be shown in the Imaging Setup tab. For ease, untick the other tracks. Click live or
continuous and focus your sample. In Switch tracks every Framemode, Adjust each track or
channel one at a time (Laser Power, Pinhole, Gain), ensuring use of full dynamic range without
saturating signal (see below).

Saturation: Tick the range indicator and aim to fill enough of the dynamic range suitable for
acquisition / analysis. Note – do this with display RESET or it will appear saturated when it isn’t.

6. Optimising acquisition: Imaging Setup and Channels

To centre and crop field of view:
Select Stage and click on image area of interest. Click Snap to see new field of view. This keeps
the best optical axis for acquisition. You can then Crop a region of interest or Zoom in.

Adjust:

Laser Power
Pinhole (1AU
for confocal /
Section
thickness)
Master gain
(600 – 800)

Full Dynamic Range

Display Range

Offset
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Note: In line wise and
frame fast wise
multitrack, you need
the same pinhole,
hardware, master gain if
using a detector more
than once



Check correct objective and immersion fluid.

Define frame size.
Optimal selects pixel size to satisfy Nyquist
criteria. Increases acquisition time if large
field of view. Note: Frame size (Pixels) does
not determine image size
Scan speed and pixel dwell time

Averaging – reduces noise
Can use line / frame

Bit depth for additional grey values 8, 12
and 16 bit (256, 4096, 65536).

Uni / Bidirectional scanning *
Scans on return, halving scan time.
(Might already be selected but hidden if
Show all not ticked)

Scan area: Note image size and pixel size
• Shift area in X and Y
• Rotate field
• Zoom. Zoom < 1 is possible but not

recommended for quantitative imaging or
tiling

• 1.0 = minimum zoon for confocal
• 1.8 = minimum zoom for Airyscan.
Reset all = quick reset button

7. Define Acquisition Mode

Bidirectional

* Bidirectional may need aligning.
This becomes visible with Show All ticked.
Correct using the Auto button, or manually (X
slider). Adjust on a single track image (not
multitrack) and without rotation.

Maintain tab, System Options, Hardware
Check ‘online scanner calibration’ is ticked.

Correction is performed online in Continuous mode (not live).7



8.Multidimensional acquisition.
A combination of functionalities can be used
to create a multidimensional experiment.
Make sure there is enough space on the hard
drive to save your experiments. Set up each
tab, then Start Experiment to run acquisition.

9. Z Stack

Setting a Z stack: Use Live (for fast live view)
FIRST / LAST:
• Focus to the bottom of your required stack and click Set Last. Then find the top and Set First.

Check the total range, slices and interval. Clicking Optimal will select appropriate Nyquist
settings for 3D imaging. Start Experiment. Save your data (autosave or stream during acquisition)

CENTRE
• Focus your specimen. Click centre, then input range and adjust slices / interval /offset as needed.
• Formultiposition Z stacks using centre, click Centre on the first position only

Tick the Z stack option and expand the new Z Stack tab that appears

Optimize Sectioning and Step in Z Stack

• A 50% overlap is optimal for 2x Nyquist 3D visualisation.
If you used Optimal for the interval, it is calculated for
you and this step is redundant.

• If you have chosen a larger Z interval and have separate
tracks, you need to adjust each channel to have equal
optical section thickness and some degree of overlap.

• Match pinhole or optimal ensures overlap is calculated
from the shortest wavelength and equalises section
thickness for each channel. The pinhole and overlap are
shown for each channel.

• X:Y:Z matches the X, Y and Z pixels, creating cubical
pixels with same resolution in XYZ.
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10. Time Series

Tick time series in experiment window and expand the Time Series tab.
Set the number of Cycles and interval. Start experiment. Save your data (!)
(Ensure you check there is sufficient space on the hard drive to save your experiment).

7. Saving data:
File > Save as > .czi. This can be viewed in Zen, and
directly imported into 3D software.
You can also export as a tiff file. File > Export (choose tiff
and appropriate options).

Check the Information on Experiment tab and ensure
enough space is available on hard drive.
Streaming (recommended) will save directly to the hard
drive as each image is acquired.
Files can be split for easier handling.
AutoSaving will save to the RAM during the experiment,
and then to the specified hard drive at the end (not
recommended).

Show all: You can add markers during your
experiment, or change certain acquisition
parameters.
These will appear as coloured square in the gallery
format at the specific time points.

Interval Time: You can create a shortcut button to
acquire at different time intervals. E.g., longer
intervals to monitor sample, then click button for
shorter intervals. Sets of intervals can be saved.
Marker: to label action.
Functionality can be set manually or set up using
triggers. Sets of marker labels can be saved.

Experimental
configurations can be
saved or you can click
REUSE to apply settings
from an image.
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11. Tiles

Tick Tiles in experiment window and expand the Tile Scan tab.
Set the number of tiles in XY. Start experiment. Save your data (use streaming !)
You will obtain a preview map that will need to be stitched in the Processing tab.

‘Show all’ mode has more functions to create
your tiled area with.
Centred grid acquires a tiled scan around a
central point.
Bounding grid will create a quadrangle
around marked positions.
Convex hull will create a tiled region that
encircles all points (like an elastic band
around the added positions). This can save
imaging blank corners of a circular sample.

Scan Overview Image allows you to choose a lower
magnification objective to make a map of the sample.
Once saved, you can click on the map to move the stage to
that position with any objective.
Note:
• Zoom 0.6 will have vignetting around each tile but it will

function as a map (not for quantitative imaging).
• Save the map to avoid overwriting it.

Stitching a tiled scan.

Go to the Processing Tab
In theMethod tab list, select Stitch. Then click Select to select the
data you want to stitch. Then Apply.
Save the stitched image – it will have the extension ‘_stitch.czi’

If stitching fails in 2D, you can
choose the Correlation Threshold
strength. This defines the accuracy
the algorithm detects similarities
in adjacent images.

Zen Blue has more flexibility for stitching.
When stitching tiled Z stacks, if the sample is flat, Ignore z shift
can improve results. If tilted, it can improve results. 10



12. Positions

A number of positions can be added to your experiment. Tick Positions in the experiment and
expand the Positions tab. There are various practical methods to add positions:

1. Click Live to view your sample, and click add each time you find a position to image. There are
buttons to Add and Remove positions when they are highlighted. Up / down will adjust position
order.Move to will go to the position highlighted.
2. View through the microscope and then add once centred in the binoculars.
3. Use Scan overview image to create a map and use the stage button to add positions from it.

Before you start your experiment, check all positions are in focus and click Update.
Move to (adjust focus / position as needed) Update.

Note: If doing multi position Z stacks, ensure stacks are added by their central position as this will
define the centre of the Z stack specified in both Centre and First and Last Z stack options.
When Show all is ticked, it will give the option to lower objective between positions. This helps to
preserve immersion fluid during multi position time series experiments (Not on Examiner).
Activating ‘Waitstate’ (Maintain tab, Systems Options, hardware) will add 350ms pause between
stage movement and acquisition. This can reduce jitter.

Adding positions from a scan overview:
You can create a tiled / scan overview, then
use this map to add positions, moving to
each position with the Stage button.
You can then verify the focus of each added
position before you start your multiposition
acquisition.
You can also use this technique to create a
map for bounding grid or convex hull, then
acquire better image quality / multichannel
on refined area. And to quickly add multiple
positions.
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13. Airyscan

Create your acquisition set up in LSM Channel
mode as single channel tracks. Tick the
Airyscan detector ChA, appropriate laser and
select the correctMBS and emission Filter
before the ChA. Repeat if using Airyscan for in
other Tracks for multiple channels. Keep
hardware and filters the same if using Switch
track every Line or Frame Fast.

Open the Maintain Tab and undock the Airyscan tab (place under Gallery area on monitor)
Tick ‘Adjust in continuous scans’ and ‘Weak or sparse samples’
You may also need the Adjust Pinhole and collimator tab

In the Channels tab, choose Airyscan mode:
SR: Increased resolution and S:N ratio. Pinhole
default = 0.2AU, total detection area 1.25AU.
R S: Increased speed and sensitivity at expense of
resolution. Pinhole 0.2AU, total detection area 2AU.
VP: Virtual pinhole. A slider will allow signal shown
from element rings with appearance of changing
pinhole post acquisition. Default pinhole 6
CO: All Airyscan detector elements are used as one
confocal detector and you can choose your pinhole.

Note: Confocal pinhole set by software to remove
stray light and allow for the Airyscan detector
alignment. Value specific to SR or RS.
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14. Airyscan: Detector Alignment – Single Track

To check Airyscan detector aligns:
Set frame to 512 x 512 pixels, max speed, no averaging, 0.5 2% laser, gain 600 – 800 and increase
as necessary.
Ensure preview is not saturated when display is reset.
Click Continuous to view sample and select the Airyscan tab to the left in the image window.
The source image, preview image and detector view can be viewed when ticked (click show all if
not available)..

Source image: Raw sum
data for the Airyscan
detector elements.

SR: Super Resolution view of
the detector elements with
pixel reassignment and
deconvolution (if checked)

Detector view: Intensity
distribution across the
detector elements

Single track / channel:
When scanning in continuous mode, the detector
view should align so the brightest elements are in
the first ring or central element. The quality status
will show Good (Waiting) when OK. Bad when not.

The source image,
preview image and
detector view can
be viewed when
ticked (click show all
if not available).

If the detector view is not responding or aligning, try:
• Close / open detector view (check numbers active

or numbers jigging at the side)
• Move/ refocus your sample so the signal is central
• Increase gain – don’t worry about saturation until

detector aligns, then reduce before acquisition.
• Increase laser (avoid bleaching sample)
• Try aligning in RS mode, or on another slide if

really weak, then untick adjust in continuous
mode. (Only one VIS line needs to be aligned).

The detector may look aligned but Good (Waiting)
may not appear. You can still acquire your image. 13

Go to the 2D tab to start an image.
Sometimes the Live / Continuous /
Snap do not work in the Airyscan
view tab. Go to the 2D tab to start an
image, or create a new document.



14

Aligning a multitrack acquisition:
To CHECK alignment, for multi track with Vis and InVis laser
lines. Scan in continuous mode and untick the InVis laser on that
track to see the AS alignment for the Vis track only. Untick
Adjust in continuous mode. Turn 405 back on and untick the Vis
laser to see the InVis alignment on the detector view.
The system aligns the Airyscan using the Vis track, and the InVis
steering mirror for the InVis track.

Multitrack Airyscan:
As for LSM, multiple Airyscan tracks can be acquired in Framemode (if different hardware) or
Line and Frame Fastmodes (if hardware and Master gain are the same for every track).
In Continuous mode, all channel detector alignments will be super imposed onto the one
detector view.
The Vis and InVis laser lines will need to be aligned to each other. Turning off each laser in turn,
while still in continuous mode, will allow viewing of each channel alignment:

Manual Alignment of InVis line:
If auto alignment fails and the 405 is not
aligned to the Vis line, you may have to adjust
Pos X InVis and Pos Y InVis so that the InVis
signal is centred on the detector view. Use
arrows, not sliders (inMaintain tab, "Adjust
Pinhole and Collimator").

Ensure Adjust in continuous mode is off
while aligning 405. Once aligned, click Store
current position directly underneath, then
tick Adjust in Continuous Mode again and
restore Vis laser.

15. Airyscan: Detector Alignment – Multi Track

16. Airyscan: Pixel Re assignment and Deconvolution:
The SR image represents the pixel reassigned image + Deconvolution.

You can adjust the strength of the filter by
deselecting auto, and adjusting slider.
A) If the filter strength of the deconvolution step is
set to 1, the image will be pixel reassignment only.
(1.4x LSM resolution).
B) Clicking Auto will add a safe deconvolution, as
calculated by the software (up to 1.7x LSM
resolution).
C) Over deconvolved creates ‘structured noise’.
Remember the new value when processing image
for export. Individual values can be processed for
each channel in Zen Blue software.

A B C



17. Airyscan: Acquisition and saving raw data

Check list before acquiring Airyscan data:
• SR – R S, VP, CO selection
• Data is not saturated
• Field of view has been stage centred
• Frame speed chosen
• Zoom is at least 1.8 (or more)
• Then select Optimal !
• …Start Experiment.

To process, Go to Processing tab.
InMethods, select Airyscan Processing.
InMethod Parameters, Select the raw image so it
appears in the thumbnails in the preview.
Check Weiner filter strength or use tick Auto
(Auto recommended as starting point).
If a Z stack, click 3D. If single plane click 2D.
Then Apply
A new image tab will appear with the post fix
_Airyscan_processing.czi
Select display – min / max to view.

This can be exported as normal .czi files.
Data size much reduced.

File > Save as
Or
Save icon below gallery view.
This will only save your raw data (and preview if opened
in Zen. You will need to process the raw data to export.

18. Airyscan: Processing for export

15

Notes:

1. Airyscan process images before stitching,
creating MIPS or unmixing etc.

2. 2D SR is available in Zen Blue for single planes.
Enhanced deconvolution for greater resolution
(120nm).

3. Zen blue Airyscan processing will also allow
different weiner filter strengths to be chosen for
each track.
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19. Airyscan: Fast

Similar to acquire, align and process as for Airyscan.

Differences to note :
Beam now shaped to acquire 4 pixels, so imaging is 4x faster
Resolution is up to 1.5 x better than LSM

Set up as for Airyscan and select the Fast tab.
For speed, set up in Line mode (same hardware and master gain).

Airyscan Fast modes:
SR: 2x Nyquist at 4x the speed of the
Airyscan detector.
Opt: 1x Nyquist
Flx: 0.7x Nyquist
FS: 0.5x Nyquist with fastest imaging speeds
(or you can decrease speed slightly and use
it for higher sensitivity in AS Fast mode)
+ button: you can choose any Nyquist value
by moving the slider

Notes:
Once selected, frame size is automatic according to Nyquist – no optimum button for pixels.
Speed (now frames per second) will affect pixel dwell time.
Increasing pixel dwell time recommended over averaging to improve image.
Zooming in and reducing the Y axis will allow faster frame rates

27 frames per second at Frame size 480x480
You cannot rotate Airyscan Fast field of view.



a. Optimise dynamic range on your brightest treatment / time point to avoid saturation in part
of your data set. (Remember to put your strongest fluorophore on your weakest signal).

i. Experimental Notes

Reduce either the laser power from the first
channel, AND / OR reduce the gain of the second
channel. Do not adjust these values when adding
the second channel laser back in.

b. Checking and reducing Cross talk in tracks with multiple channels:

c. Checking for Photobleaching:

Deselect the laser with the longest wavelength all signal should disappear in that channel.
Remaining signal may be cross talk.

Select Time Series
Select e.g. 500 cycles at 100ms interval
(avoids dark state). Use c.600 gain.
Click Start Experiment

In image display, select ROI tab
In the ROI tab under image, create an ROI
region in the image
The ROI Intensity vs Time plot will appear
for each channel.
Check for decrease in intensity with time.
If a decrease (bleaching) is evident,
decrease the laser power (*) until the
signal levels, use gain to fill dynamic range.
If no bleaching, you could increase your
laser / lower your gain for a better signal.
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ii. Time Series, Bleaching and Regions (FRAP)

Create regions across your sample in the Regions tab. Reference and Background regions can be
added before or after (if added before, ensure bleaching is unticked for these control regions).
Create a continuous scanning mode in the Time Series tab. E.g. 10000 cycles, 0.0 interval.

FRAP (Fluorescence Recovery
After Photobleaching) can be
monitored using Bleaching,
which automatically
combines Time and Regions.
Intensity profiles for each ROI
can be viewed once you have
started the experiment.

Bleaching.
• Start bleaching after… : Creates baseline
• Repeat Bleach: Sets interval between bleaching
• Iterations: Total number of scans performed for

bleaching of selected region (Frame)
• Stop when intensity…: in repeat bleaching,

bleaching will stop at the specified intensity
• Different scan speed: determines pixel dwell time

during bleaching event. Bleaching efficiency is
increased with increased dwell time. To reduce
irreversible photodamage, this can be combined
with Iterations.

• Safe bleach for GaAsp: protects detector. Adds
100ms to each cycle. Try first without, if detector
shuts off due to overexposure, add to experiment.

• Zoom Bleach: Restricts scanning and bleaching to
ROIs only.

• ROIs: define control / bleaching parameters.
• Different bleaching settings can be set for ROI’s..
• Configurations can be saved / reloaded.

Note: If bleaching efficiency is not obtained after
increasing pixel dwell time or iterations, the 488nm
laser can be run at
maximum / twice the
power (Visible when
Show All is ticked).
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Experimental Note: To speed
bleaching, create ROIs within a
small Y range. In normal mode (not
zoom bleach) the scanners scan
the whole width (X) but start at the
topmost ROI and stop at the
bottom most ROI.
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Airyscan:
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Choosing the right objective:
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Confocal Microscopy:
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Resolution: Signal and Pinhole size
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Scanning system and scanning strategies:
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More scanning strategies:
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